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b) Google chrome 
c) Netscape 
d) Firefox 
e) None of these 
Ans: A 

7. In MS Excel 2010, the shortcut key to apply or
remove bold formatting is: a) Ctrl + 4 b) Ctrl + 3 c)
Ctrl + 2 d) Ctrl + 5 

5. Which one of the following is not a social
networking site?
a) Facebook
b) Notebook
c) LinkedIn
d) Twitter
e) All of the above 
Ans: C 

6. What is the decimal equivalent of the binary
addition of 1010 and 0101? a) 15 b) 20 c) 19 d)
14 e) 21 Ans: A 1010 = 10 and 0101 = 5 

e) Ctrl + 1
Ans: C 
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9. A Keyboard, other than being an input device
is a _____
a) Touch device
b) DAG converter
c) Terminal
d) Dumb Terminal
e) None of these
Ans: D
A dumb terminal is a very simple device with
very little processing power and features 

10. The right procedure to add a water mark in
MS EXCEL 

a) Insert > Header & Footer > Design tab on the
ribbon >Picture
b) Insert >Picture
c) Insert > Header & Footer > Design tab on the
ribbon >Picture
d) Insert > Clip Art > Design tab on the ribbon 

8. Word processing, Spreadsheet, and Google
chrome are examples of ___
a) Application Software
b) Operating system software
c) System Software
d) Device drivers
e) None of these 
Ans: A 
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1. A computer program that records every 
keystroke made by a computer user, especially 
in order to gain fraudulent access to passwords 
and other confidential information is called 
a) Screen Recorder 
b) Keylogger 

2. Which of the following is not a programming 
language? 
a) C 
b) C++ 
c) FORTRAN 
c) BASIC 
e) Solaris 
Ans: E 
Solaris is an enterprise Operating system for 
Oracle Database and Java applications. Rest all 
are programming languages. 

c) Lightstroke Reader 
d) Key Capture 
e) Malwares 

Ans: B 
A keylogger, sometimes called a keystroke 
logger or keyboard capture, is a type of 
surveillance technology used to monitor and 
record each keystroke on a specific computer. In 
an alternative way, Keyloggers are a particularly 
insidious type of spyware that can record and 
steal consecutive keystrokes (and much more) 
that the user enters on a device 

3. The situation of having an identical piece of 
data stored in two different locations is known 
as __________ and is created by databases or 
other data storage technologies. 
a) Data Encapsulation 
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4. Which Script enabled the production of client-
side dynamic web pages executed in the client's
browser? a) PHP b) Java Script c) Ruby d) Bash
e) Python Ans: B JavaScript enables the
production of client-side dynamic web pages,
with the JavaScript code executed in the client's
browser. 

5. Which of the following is invalid Statement
regarding generation of computer? 

a)
generation: 1946-1959. Vacuum tube based.
b) Second Generation The period of second 

First Generation The period of first 

 
b) Data Abstraction 
c) Data Redundancy 
d) Data Polymorphism 
e) Data Duplication 
Ans: C 
Data redundancy occurs when the same piece 
of data exists in multiple places, whereas data 
inconsistency is when the same data exists in 
different 
Unfortunately, data redundancy can cause data
inconsistency, which can provide a company
with unreliable and/or meaningless information. 

formats in multiple tables. 
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7. Alt, Ctrl are __________ keys.
a) Stroke Keys
b) Lock Keys
c) Candidate Keys
d) Shortcut Keys
e) Modifier Keys
Ans: E
A modifier key is a keyboard key that can only 
be used in conjunction with another key when 
using a computer. Ctrl, Alt, and Shift are the 
modifier keys on a typical modern keyboard 

6. Which OSI layer specifies how two devices
should compress, encrypt, and encode data so it
may be successfully received on the other end?
a) Application Layer b) Network Layer c) Data-link
Layer 
d) Physical Layer 
e) Presentation Layer 
Ans: E 

generation: 1959-1965. Transistor based. c) Third
Generation The period of third generation: 1965-
1971. Integrated Circuit based. d) Fourth
Generation The period of fourth generation: 1971-
1980. VLSI microprocessor based. e) All are
correct Ans: E 
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10. A firewall is software or firmware that 

8. Which of the following forms of transmission
occurs during walkie-talkie communication? a)
Simplex b) Full —Duplex c) Half-Duplex d)
Online e) None of these Ans: C 
In half-duplex mode, both the transmitter and 
receiver transmit and receive, but not at the 
same time. When one of them is sending, the 
other can only receive, and vice versa. Example: 
Walkie-talkie in which message is sent one at a 
time and messages are sent in both directions. 

9. In which type of disc the data can be written
only once and cannot be erased? a) CD-
RW/DVD-RW b) BD-R c) DVD-ROM/CD-ROM
d) HD-DVD e) CD-R/DVD-R Ans: E With CD-R
discs, you can only write to them once, but you
can read from them repeatedly. 
You can write to CD-RW discs numerous times 
and read content from them an infinite number 
of times. 
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11. The BIOS settings are stored in the
____________ chip which is kept powered up via
the battery on the motherboard
a) EPROM
b) UEFI
c) PMOS
d) CMOS
e) None of these
Ans: D
BIOS, or Basic Input/Output System, is software
stored on a small memory chip, also known as
firmware. BIOS is found on the motherboard,
and it is the very first software to run after a
computer starts. Generally, the terms BIOS and
CMOS are used interchangeably. A BIOS chip 

in a motherboard contains the program
(firmware commonly called BIOS) to boot the 

computer. A CMOS chip stores the settings like 

prevents ___________________ a) Access to
internetwork files b) Access to intranetwork files c)
Access to files from public IP addresses d)
Access to logic bomb files e) Unauthorized
access to a network Ans: E A firewall is essential
software or firmware in network security that is
used to prevent 
unauthorized access to a network. It inspects 
incoming and outgoing traffic using a set of 
security rules to identify and block threats. 
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13. Which of the following convert high level
language to low level language?
a) Loader
b) Linker
c) Editor
d) Assembler
e) Compiler 

 
date & time, fan speed, booting sequence. The 
CMOS is also a chip on the motherboard but is 
a RAM chip with volatile memory which stores 
information about the computer components and 
their settings 

12. Simple Mail Transfer Protocol (SMTP)
Protocol is used for sending or receiving
__________. a) Source Code b) Object Files c)
Executable Files d) .info files 
e) e-mail between e-mail clients and servers 
Ans: E 
The Simple Mail Transfer Protocol (SMTP) is 
used for sending and receiving e-mail between 
e-mail clients and servers. When an SMTP 
server receives an e-mail from a mail client, the 
SMTP server will then check the MX records for 
the domain in the e-mail address in order to 
exchange the mail with the remote SMTP 
server. 

15. Which shortcut key is used
presentation from the beginning?
a) F12
b) F1
c) Shift + F9
d) Ctrl+ F2 

to start 
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a 

14. ___________ refers to the gap between
demographics and regions that have access to 

modern
technology, 

information and communications
have and those that don't or 

restricted access. a) SMPS b) Virtual Data Drive 
c) Circuit Switching 
d) Analog Divide 
e) Digital Divide 
Ans: E 
The digital divide is a term that refers to the gap 
between demographics and regions that have 

access to modern information and communications technology (ICT), and those
that don't or have restricted access. 

Ans: E A compiler is a special program that
translates a programming language's source code
into 
machine code, bytecode or another programming language. The source code
is typically written in a high-level, human-readable
language such as Java or C++. 
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e) F5 
Ans: E 

18. Which of the following statements is not true
about cache memory? 

16. Which of the following malicious program do
not replicate automatically?
a) Virus
b) Worm
c) Zombie
d) Logic bomb
e) Trojan horse Virus 
Ans: E 
Until a user executes the Trojan it can’t replicate 
itself. 

17. USB and Various Ports are controlled by
______________. a) Serial Ports b) SATA c) PATA
d) South Bridge of Motherboard 

e) None of these 
Ans: D The Southbridge is one of the two chips in
the core logic chipset on a personal computer
(PC) 

motherboard. implements the slower capabilities
of the motherboard in Northbridge/Southbridge
chipset computer architecture. 

The Southbridge typically 
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a) Cache memory is a form of Read Only
Memory (ROM) 
b) It is directly associated with the 
microprocessor.
c) Cache memory can be accessed much faster
by a microprocessor in comparison to a RAM.
d) Cache memory is sometimes called CPU
memory.
e) All of these 
Ans: A 
Cache Memory is a form of Read Only Memory 
(ROM) is not true about cache memory 

20. A modem ___________________
a) Translates analog signals from a computer 

into digital signals that can travel along 

19. Which tool do you choose in PowerPoint to
apply a transition to the current slide? a) View
b) Review c) SlideShow d) Transition e)
Animation Ans: D On the Transitions tab, under
Transition to This Slide, click the transition that
you want to apply. To change to a different
variation of the transition, such as the direction
it moves on the screen, click Effect Options,
and then select the variation you want 
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22. The combination of White Hat and Black Hat
hackers are _________.
a) Jailbreakers
b) Hackers
c) Crackers
d) Grey Hat Hacker
e) None of these 

21. What are the steps involved in animating an
element/text in power point presentation?
a)Text/Element>AnimationTab>animation>effect
.
b)Text/Element>SlideShow>animation>effect.
c)Text/Element>Review>animation>effect.
d)Text/Element>View>animation>effecte) None
of these
Ans: A
Text/Element>AnimationTab>animation>effect. 

 
conventional telephone lines. 
b) Translates digitals signals from a computer 
into 
conventional telephone lines. 
c) Demodulates digital signals from a computer. 
d) Modulates signals from an analog telephone 
life 
e) None of These 
Ans: B 
A Modem translates digitals signals from a
computer into analog signals that can travel along
conventional telephone lines 

analog signals that can travel along 
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24. Which of the following CD technologies is
also WORM technology?
a) CD-RW
b) CD-Photo/Photo CD
c) CD-I (Compact Disc Interactive
d) CD-R
e) None of these
Ans: D 
Compact Disc-Recordable (CD-R) technology is 

23. What is the term used for the time during
which a job is processed by the system? a)
Turnaround time b) Scheduling time c) Waiting
time d) Job time e) Execution Time/ CPU time 
Ans: E 
Burst time, also referred to as <execution time=. 
It is the amount of CPU time the process 
requires to complete its execution. It is the 
amount of processing time required by a 
process to execute a specific task or unit of a 
job. 

Ans: D Between white and black are grey hat
hackers. Grey hat hackers enact a blend of both
black hat and white hat activities. Grey hat
hackers often look for vulnerabilities in a system
without the owner's permission or knowledge. 
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27. What is the size of IPv4?
a) 38-bit b) 16-bit 

 
known as Write Once-Read Many (WORM) 
technology as data once written on these discs 
cannot be erased. 

26. What does AB8 means in Excel?
a) Row AB Column 8
b) Row A Cell B Column 8
c) All are possible rendition
d) None of these
e) Column AB and Row 8
Ans: E
AB8 in MS- Excel means Column AB and Row 
number 8 

25. A ______________ is a CPU register in the
computer processor which has the address of
the next instruction to be executed from
memory. a) Memory Pointer b) File Pointer c)
Data Pointer 
d) Instruction Pointer 
e) Program Counter (PC) 
Ans: E 
The program counter, PC, is a special-purpose 
register that is used by the processor to hold the 
address of the next instruction to be executed 

c) 32-bit d) 64-bit
e) None of these
Ans: C 

29. What is the other name of URL?
a) Subset Web address
b) Superset Web address
c) Archive site
d) Index page address
e) Web Address
Ans: E 
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28. ________________ is the supply of computer 
services like data storage, servers, and 
databases through the Internet. a) IoT b)
Blockchain c) ICT d) ISA 
e) Cloud computing is the supply of computer 

services like data storage, servers, and 
databases through the Internet. 
Ans: E 
Cloud computing is on-demand access, via the 
internet, to computing resources—applications, 
servers (physical servers and virtual servers), 
data storage, development tools, networking 
capabilities, and more—hosted at a remote data 
center managed by a cloud services provider (or 
CSP). 
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URL or the uniform resource locator is the other 
name of the Website Address 

31. Which of the following is not a valid form of
Memory? a) ROM b) FORM c) PROM d)
EPROM e) None of these Ans: B 

30. Which of the following is a very high-speed
semiconductor memory which can speed up the
CPU? a) Primary Memory b) Optical Disk 

c) SSD
d) Secondary Memory 
e) Cache Memory 

Ans: E 
Cache memory is a very high-speed 
semiconductor memory which can speed up the 
CPU. Cache memory acts as a buffer between 
the main memory and the CPU. It holds the 
most frequently used part of the program and 
data. 

32. Which shortcut key is used to go to Home in
MS-Excel ?
a) Alt+A 

b) Ctrl+F
c) Ctrl+T
d) Alt+F2
e) Alt+H
Ans: E 

35. Convert (010111010)2 into Octal
a) 287
b) 256
c) 254
d) 298
e) 272
Ans: E 

33. Ctrl + B Shortcut key is used to _______
a) Add a hyperlink
b) Make selection italic
c) Make selection Superscript
d) Make selection Subscript
e) Make Selection Bold
Ans: D 
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34. Convert (10101110)2 into Hexadecimal. a) AC
b) FD c) AE d) CD e) AB Ans: C 10101110 to
decimal equals to 174. Then convert (174)10 to
Hexadecimal, i.eAE 
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010 111 010. Grouping them into three’s. 2
2

7

37. examples of ____ printers. a) Impact Printers
b) Semi-impact Printers c) Hashed out Printers d)
Priority Printers e) Non-Impact Ans: E 
Non-impact printers create pictures, characters, 
and figures without any uninterrupted contact 
between the printing device and the paper. 

Inkjet printers and laser printers are 

36. When a user try to access a resource on a
web server (usually a web page) that doesn't
exist, which type of Error exist that time? a)
HTTP Error 505 b) HTTP Error 302 c) HTTP
Error 405 d) HTTP Error 403 
e) HTTP Error 404 
Ans: E 
The Web server returns the HTTP 404 - File not 
found error message when it cannot retrieve the 
page that was requested. The following are 
some common causes of this error message: 
The requested file has been renamed. The 
requested file has been moved to another 
location and/or deleted. 
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38. Which of the following keyboard key is used
in a Microsoft PowerPoint presentation to select 

one hyperlink after another during a slide 
presentation?
a) Shift+O b)
Ctrl+P c)
Alt+H 
d) F1 
e) Tab 
Ans: E 

39. Flash memory is a non-volatile computer
storage chip made up of __________________.
a) DROM
b) MROM
c) PROM
d) EPROM
e) EEPROM
Ans: E
EEPROM is the acronym of electrically erasable
programmable read-only memory, EEPROM is a
Programmable ROM that can be erased and
reprogrammed using an electrical charge. It was 
first was developed by George Perlegos. It 
allows the user to update the computer BIOS 
without having to open the computer or remove 
any chips. 

Laser printers, Inkjet printers and Thermal printers
are some examples of Non-Impact printers. 
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40. In which network every host is connected to
a central hub?
a) Bus topology
b) Mesh topology
c) Ring topology
d) Hybrid topology
e) Star topology
Ans: E 

In this network, topology nodes are connected to
a central hub. Nodes communicate across the
network by passing data through the hub. Failure
in one of the terminals does not affect any other
terminal. This network topology is used to connect
terminals to a large time- sharing host computer. 
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